Note

Before using this information and the product that it supports, read the information in "Notices and trademarks" on page 41.
# Contents

## Chapter 1. Overview of InfoSphere Data Click

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>1</td>
</tr>
</tbody>
</table>

## Chapter 2. Roles for using InfoSphere Data Click

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>3</td>
</tr>
</tbody>
</table>

## Chapter 3. Configuring and administering InfoSphere Data Click

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>5</td>
</tr>
<tr>
<td>Verifying the installation of InfoSphere Data Click components</td>
<td>5</td>
</tr>
<tr>
<td>Preparing InfoSphere Information Server</td>
<td>7</td>
</tr>
<tr>
<td>Creating InfoSphere Data Click users</td>
<td>7</td>
</tr>
<tr>
<td>Assigning the user role to the project</td>
<td>8</td>
</tr>
<tr>
<td>Importing and compiling offload job templates</td>
<td>8</td>
</tr>
<tr>
<td>Consistent database metadata</td>
<td>9</td>
</tr>
<tr>
<td>Making database objects available for offload activities in InfoSphere DataStage</td>
<td>10</td>
</tr>
<tr>
<td>Configuring a IBM InfoSphere Change Data Capture service in IBM InfoSphere Data Click</td>
<td>11</td>
</tr>
<tr>
<td>Configuring a shared CDC library</td>
<td>12</td>
</tr>
<tr>
<td>Defining source and target data stores in InfoSphere Change Data Capture</td>
<td>12</td>
</tr>
<tr>
<td>Configuring InfoSphere Data Click in InfoSphere Blueprint Director</td>
<td>14</td>
</tr>
<tr>
<td>Installing the InfoSphere Data Click file</td>
<td>14</td>
</tr>
<tr>
<td>Setting default policies</td>
<td>15</td>
</tr>
<tr>
<td>Specifying InfoSphere Information Server connections</td>
<td>15</td>
</tr>
<tr>
<td>Specifying InfoSphere Change Data Capture connections</td>
<td>16</td>
</tr>
</tbody>
</table>

## Chapter 4. Offloading data

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>17</td>
</tr>
<tr>
<td>Creating an InfoSphere Data Click blueprint</td>
<td>17</td>
</tr>
<tr>
<td>Configuring and publishing an offload</td>
<td>19</td>
</tr>
<tr>
<td>Distributing published blueprints</td>
<td>20</td>
</tr>
<tr>
<td>Viewing and submitting offload requests</td>
<td>20</td>
</tr>
<tr>
<td>Tailoring the offload request</td>
<td>21</td>
</tr>
<tr>
<td>Viewing offload activities</td>
<td>22</td>
</tr>
<tr>
<td>Viewing scheduled offloads</td>
<td>23</td>
</tr>
<tr>
<td>Checking offload jobs in the Operations Console</td>
<td>23</td>
</tr>
<tr>
<td>Viewing metadata generated by offloads</td>
<td>24</td>
</tr>
<tr>
<td>Running jobs or starting subscriptions from offload requests</td>
<td>25</td>
</tr>
<tr>
<td>Submitting or resubmitting offload jobs</td>
<td>25</td>
</tr>
<tr>
<td>Submitting or resubmitting offload subscriptions</td>
<td>26</td>
</tr>
</tbody>
</table>

## Chapter 5. Managing change to sources and targets

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>29</td>
</tr>
</tbody>
</table>

## Chapter 6. Troubleshooting InfoSphere Data Click

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>31</td>
</tr>
</tbody>
</table>

## Appendix A. Product accessibility

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix A</td>
<td>35</td>
</tr>
</tbody>
</table>

## Appendix B. Contacting IBM

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix B</td>
<td>37</td>
</tr>
</tbody>
</table>

## Appendix C. Accessing and providing feedback on the product documentation

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix C</td>
<td>39</td>
</tr>
</tbody>
</table>

## Notices and trademarks

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notices and trademarks</td>
<td>41</td>
</tr>
</tbody>
</table>

## Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>45</td>
</tr>
</tbody>
</table>
Chapter 1. Overview of InfoSphere Data Click

IBM® InfoSphere® Data Click simplifies data movement and eases data placement. You can use InfoSphere Data Click to offload warehouse databases or offload select schemas and tables within warehouse databases.

You can use InfoSphere Data Click to retrieve data and work on that data in a test environment. You can move data from an operational database to a private sandbox. You can isolate the data to experiment with data transformations, or you can create reports from subsets of the data. By isolating and analyzing the data in a test environment, you do not jeopardize the integrity of the business information in the production environment.

InfoSphere Data Click relies on IBM InfoSphere DataStage® and can also use IBM InfoSphere Change Data Capture to provide efficient extraction, high throughput, and with minimum risk to your production system.

You can monitor offload requests by using IBM InfoSphere DataStage and QualityStage® Operations Console or the IBM InfoSphere Change Data Capture Management console. You can use IBM InfoSphere Information Server Web console to monitor and manage scheduled offload activity.

The user roles in InfoSphere Data Click are the administrator and the user. The role of the InfoSphere Data Click user is to submit offload requests. The user can modify offload requests based on the policies set by the administrator. The user might or might not be enabled to actually run an offload request. The InfoSphere Data Click administrator defines offload policies and user privileges.

The administrator completes set up of the InfoSphere Data Click environment. Setup activities include the following tasks:

- Preparing the InfoSphere Information Server environment
- Configuring an InfoSphere CDC service
- Configuring InfoSphere Data Click in InfoSphere Blueprint Director
- Creating and publishing offload blueprints to distribute to the team

The administrator fulfills offload requests, if the user is not enabled to do so. The administrator also ensures that updates to source and target metadata are reflected in the InfoSphere Data Click environment.
Chapter 2. Roles for using InfoSphere Data Click

To use InfoSphere Data Click, you need an InfoSphere Data Click administrator and InfoSphere Data Click users.

InfoSphere Data Click administrators and users perform distinct roles in InfoSphere Data Click.

InfoSphere Data Click Administrator
An Administrator can:
- Prepare the InfoSphere Information Server environment
- Set default policies
- Define user privileges
- Create and publish blueprints
- Configure InfoSphere Data Click
- Create and run offloads

The administrator fulfills offload requests, if the user is not enabled to do so.

InfoSphere Data Click User
A User can:
- Run offloads
- Modify offloads as determined by policies

The user might or might not be enabled to actually run an activity.

Suite roles for InfoSphere Data Click Administrators

Administrators need these additional roles to use InfoSphere Data Click.

InfoSphere Information Server Suite User
Administrators need this role before they can submit offload requests in InfoSphere Data Click.

DataStage and QualityStage Administrator
Administrators need the InfoSphere DataStage Administrator role if they want to
- Change the work load manager settings for InfoSphere Data Click
- Assign InfoSphere Data Click users the DataStage Operator role
- Import InfoSphere Data Click offload jobs into a project
- Compile the InfoSphere Data Click offload jobs in a project

Metadata Workbench Administrator
Administrators need this role if they want to view operational metadata.

Business Glossary User
Administrators need this role if they want to access the blueprint viewer from InfoSphere Business Glossary.

Common Metadata Administrator
Administrators need this role if they want to import metadata into the metadata repository by using InfoSphere Metadata Asset Manager or IBM InfoSphere DataStage and QualityStage Designer.
Suite roles for InfoSphere Data Click Users

Users need these additional roles to use InfoSphere Data Click.

**InfoSphere Information Server Suite User**
Users need this role before they can submit offload requests in InfoSphere Data Click.

**DataStage and QualityStage User**
Users need this role only if they will be enabled to use InfoSphere DataStage to run offloads.

**Business Glossary User**
Users need this role if they want to access the blueprint viewer from InfoSphere Business Glossary.

**Metadata Workbench User**
Users need this role if they want to access the blueprint viewer from InfoSphere Metadata Workbench.

InfoSphere DataStage roles

You need these additional InfoSphere DataStage roles to use InfoSphere Data Click features.

**DataStage Operator**
InfoSphere Data Click users need this role for the InfoSphere DataStage project that they will be working with in InfoSphere Data Click. This role allows them to run and manage DataStage jobs.
Chapter 3. Configuring and administering InfoSphere Data Click

You prepare your offload environment. You create connections to sources and targets, set up the job environment, create data stores for subscription environments, and define offload policies.

IBM InfoSphere Information Server provides the underlying engine that processes offload requests.

IBM InfoSphere DataStage manages database metadata associated with offload requests, and runs offload requests as job instances. You can also synchronize sources and targets by creating offloads as subscriptions in IBM InfoSphere Change Data Capture. You can create offload subscriptions in IBM InfoSphere Change Data Capture.

In IBM InfoSphere Blueprint Director, you set controls that govern offload requests. You then can tailor offload requests in the InfoSphere Data Click web-based wizard.

Verifying the installation of InfoSphere Data Click components

After IBM InfoSphere Data Click components are installed with the IBM InfoSphere Information Server installation program, you need to verify that the InfoSphere Data Click project was installed correctly.

Before you begin

When you install InfoSphere DataStage, some InfoSphere Data Click components are also installed.

The following graphic displays a topology for the InfoSphere Data Click components.
When you configure InfoSphere Data Click, you complete deployment of some of the Data Click components shown in the topology. For example, you install the InfoSphere Data Click plugin and configure InfoSphere Data Click in IBM InfoSphere Blueprint Director.

An application named BPDServer is needed by InfoSphere Data Click and is deployed as part of InfoSphere Metadata Workbench.

**Procedure**

1. Open the IBM InfoSphere DataStage and QualityStage Administrator client.
2. Verify that an InfoSphere Data Click project exists.
3. Verify that the project properties are set.
   - Enable runtime column propagation for parallel jobs.
   - Enable runtime column propagation for new links.
   - Share metadata when importing from connectors.
   - Optionally, generate operational metadata. You can enable the collection of operational metadata. Specify this property if you want to be able to load operational metadata from offload request into IBM InfoSphere Metadata Workbench.
What to do next

You use administrative privileges to complete the setup of InfoSphere Data Click in the InfoSphere Information Server environment.

Optionally, you complete the setup of InfoSphere Data Click to work in IBM InfoSphere Change Data Capture environment.

You also must complete additional steps to install IBM InfoSphere Data Click in IBM InfoSphere Blueprint Director.

Related tasks:

- “Preparing InfoSphere Information Server”
  You create credentials, compile template jobs, and import metadata from offload source and target databases.

- “Configuring a IBM InfoSphere Change Data Capture service in IBM InfoSphere Data Click” on page 11
  You configure an association between IBM InfoSphere Change Data Capture and InfoSphere Data Click so that offload requests can be processed by InfoSphere Change Data Capture as a service.

- “Configuring InfoSphere Data Click in InfoSphere Blueprint Director” on page 14
  You govern IBM InfoSphere Data Click activities from IBM InfoSphere Blueprint Director. You can set default policies for all InfoSphere Data Click activities, configure connections to source and target databases and create offload blueprints.

Preparing InfoSphere Information Server

You create credentials, compile template jobs, and import metadata from offload source and target databases.

About this task

The IBM InfoSphere Information Server platform provides an integrated architecture that eases the complexity of offloading data between databases. IBM InfoSphere Data Click uses the single shared metadata repository in InfoSphere Information Server to share data while ensuring consistent and current data.

The tasks described in this section are completed by an administrator and usually need to be completed only once.

Creating InfoSphere Data Click users

Although you can use existing user names with IBM InfoSphere Data Click, you can create a user and an administrator that have the appropriate credentials.

Before you begin

You must have IBM InfoSphere Information Server administrator level access to create InfoSphere Data Click users.

About this task

The InfoSphere Data Click administrator creates and publishes the InfoSphere Data Click blueprint and must be a Metadata Workbench administrator and a Suite User.
InfoSphere Data Click users, who submit offload requests, must have the following credentials:

- Suite User
- DataStage and QualityStage user, only if the user will be enabled to use InfoSphere DataStage to run offloads
- Business Glossary User, if the user accesses the blueprint viewer from InfoSphere Business Glossary
- Metadata Workbench User, if the user accesses the blueprint viewer from InfoSphere Metadata Workbench

**Procedure**

1. Open the IBM InfoSphere Information Server Web console.
2. Click the Administration tab, and then click **Users and Groups > Users**.
3. In the Users pane, click **New User**.
4. Specify the user name and password for the new InfoSphere Data Click user.
5. Assign the following InfoSphere Information Server roles to the InfoSphere Data Click user that you created:
   - Suite User
   - DataStage and QualityStage user, if applicable
   - Business Glossary User, if applicable
   - Metadata Workbench User, if applicable
6. Click **Save and Close** to save the user information in the metadata repository.
7. Repeat Steps 3 and 4 to create an administrator user.
8. Assign the suite component roles of Suite User and Metadata Workbench Administrator to the InfoSphere Data Click administrator user that you created.
9. Click **Save and Close**, and then exit the web console.

**Assigning the user role to the project**

You must assign the user role to the IBM InfoSphere Data Click project.

**Before you begin**

You **create an InfoSphere Data Click user** that is assigned multiple roles, including the user role DataStage and QualityStage user.

You must be an InfoSphere DataStage administrator to assign user roles to the InfoSphere Data Click project.

**Procedure**

1. Open the IBM InfoSphere DataStage and QualityStage Administrator client.
2. Select the InfoSphere Data Click project.
3. On the Permissions page, click Add **User or Group**.
4. Select the user or group that includes the DataStage and QualityStage Operator and add it to project list of roles.
5. Click **OK** to save and then close the Administrator client.

**Importing and compiling offload job templates**

You import and then compile job templates that implement offload requests in IBM InfoSphere DataStage and QualityStage Designer.
Before you begin

Ensure that the properties for the InfoSphere Data Click project include runtime column propagation.

You must be an InfoSphere DataStage administrator to import objects into the project.

About this task

In the IBM InfoSphere Data Click project, you prepare the job templates for use.

When users generate offload requests, the request can be fulfilled through a job instance. All job instances are generated from job templates in the Designer client.

Procedure

1. Open the Designer client.
2. Enter your InfoSphere DataStage credentials and select the InfoSphere Data Click project. Click Login.
3. Select Import > DataStageComponents.
4. In the Import from file field, go to the InfoSphere Data Click directory on the engine tier and select the .dsx file. For example,
   - For Windows operating systems: IBM/InformationServer/Server/DataClick/bin/DataClickOffloadWindows.dsx
   - For UNIX operating systems: IBM/InformationServer/Server/DataClick/bin/DataClickOffloadUnix.dsx
5. Ensure Import All is selected and then click OK to import the template jobs and job parameters into repository folders.
6. Compile each InfoSphere Data Click job.
   a. Navigate to the job templates.
   b. Select the jobs.
   c. Click Tools > Multiple Job Compile.

What to do next

You import metadata from source and target databases into the IBM InfoSphere Information Server metadata repository. The metadata in the repositories of the products that participate in offload activities must match each other in order for InfoSphere Data Click to successfully generate jobs or subscriptions.

Related tasks:

“Making database objects available for offload activities in InfoSphere DataStage” on page 10

You must import metadata for every source and target database that you want to make available for offload request. One reason that you import the metadata is to ensure that connection information is available during the processing of offload request.

Consistent database metadata

IBM InfoSphere Data Click works with data integration products that have their own metadata repositories, such as IBM InfoSphere DataStage and IBM InfoSphere
Change Data Capture. The metadata in the repositories of the products must match each other in order for InfoSphere Data Click to successfully generate jobs or subscriptions.

For example, if you offload data from a DB2® database to a Netezza® database, you must ensure that you maintain consistency between the metadata associated with the DB2 database and the metadata associated with the Netezza database.

You must ensure that you maintain consistency between metadata associated with all databases that you offload data from. You can offload data between the following source and target databases:

- DB2 to Netezza
- Oracle to Netezza
- Databases with ODBC connections to databases with ODBC connections

You can create offload subscriptions in IBM InfoSphere Change Data Capture. However, you cannot create subscriptions if use the ODBC connector to move data.

InfoSphere Data Click looks for the metadata definition for both the source and target database. Actions against target tables that occur during offload (such as create, replace, or append) are generated based on the presence of metadata in the repository.

**Related tasks:**

1. "Making database objects available for offload activities in InfoSphere DataStage"
   You must import metadata for every source and target database that you want to make available for offload request. One reason that you import the metadata is to ensure that connection information is available during the processing of offload request.

2. "Defining source and target data stores in InfoSphere Change Data Capture” on page 12.
   You define data stores that contain the database tables and views that users can access for offload activities. You match the name of the data stores to the database definitions in the InfoSphere Information Server metadata repository.

**Making database objects available for offload activities in InfoSphere DataStage**

You must import metadata for every source and target database that you want to make available for offload request. One reason that you import the metadata is to ensure that connection information is available during the processing of offload request.

**Before you begin**

You must be an InfoSphere DataStage administrator to import metadata to the metadata repository, through the InfoSphere Data Click project.

**About this task**

The following tasks describes how to import the metadata through the project. You can also use IBM InfoSphere Metadata Asset Manager to import the metadata. You must have the role of Common Metadata Administrator to import metadata from InfoSphere Metadata Asset Manager. You must also ensure that database connection information is saved during the import.
The DB2Connector, OracleConnector, NetezzaConnector, and ODBCConnector are supported.

**Procedure**

1. Open the InfoSphere DataStage and QualityStage Designer client.
2. From the Import menu, select **Table Definitions > Start Connector Import Wizard**.
3. Select the connector that you need to access database objects and then click **Next**.
4. Specify the database connectivity information.
5. Click **Save**. The connection information is saved to the metadata repository. InfoSphere Data Click cannot connect to the database when the connection information is not saved, and offload activities fail.
6. Click **Next** and continue through the dialog windows. Specify the data source location, specify the schema and any filters, and select the specific tables and views to import.
   
   If you choose to create your own database name, when identifying the data source location, you must provide the DBMS type. (You might create database names so that you can organize or limit the tables and views that are made available to offload users.) Specify the DBMS for your database exactly as listed:
   
   - DB2
   - NetezzaSQL
   - Oracle

7. Repeat the proceeding steps until you complete import of all the database objects that you want to make available to IBM InfoSphere Data Click users.
8. Close the window.
9. Optional: Open IBM InfoSphere Metadata Asset Manager to view the database objects as metadata in the metadata repository.

**Related concepts:**

["Consistent database metadata” on page 9](#)

IBM InfoSphere Data Click works with data integration products that have their own metadata repositories, such as IBM InfoSphere DataStage and IBM InfoSphere Change Data Capture. The metadata in the repositories of the products must match each other in order for InfoSphere Data Click to successfully generate jobs or subscriptions.

---

**Configuring a IBM InfoSphere Change Data Capture service in IBM InfoSphere Data Click**

You configure an association between IBM InfoSphere Change Data Capture and InfoSphere Data Click so that offload requests can be processed by InfoSphere Change Data Capture as a service.

**About this task**

The tasks described in this section are completed by an administrator and usually need to be completed only once.
Configuring a shared CDC library

You might need to update the classpath for an API file that is shared between IBM InfoSphere Change Data Capture Access Server and the IBM InfoSphere Information Server environment.

About this task

IBM InfoSphere Data Click components are installed with the InfoSphere Information Server installation program. As part of the installation procedure, a CDC shared library is created and associated with InfoSphere Data Click. The shared library is configured based on the following default locations:

- For Windows operating systems: C:\Program Files (x86)\IBM\InfoSphere Change Data Capture\Access Server\lib
- For UNIX operating systems: /opt/IBM/cdc/lib

If InfoSphere Change Data Capture is on the same computer as InfoSphere Information Server and you did not change the default location for files, you do not need to complete this task. Otherwise, follow the steps in this task to check the classpath for the shared api.jar file.

You log in as the InfoSphere Information Server administrator to complete the task steps.

Procedure

1. Locate the installation directory for InfoSphere CDC and find the api.jar file.
2. Start the IBM WebSphere® Application Server administrative console. You log in with IBM WebSphere Application Server administrator privileges.
3. View the CDC shared library and, if needed, update the classpath information.
   a. In the text box for the Classpath, enter the absolute path for the api.jar file. Do not include the file name.
   b. Click Apply and save the shared library to the master configuration.
4. Stop and start IBM WebSphere Application Server. Then, start IBM WebSphere Application Server administrative console again.

Defining source and target data stores in InfoSphere Change Data Capture

You define data stores that contain the database tables and views that users can access for offload activities. You match the name of the data stores to the database definitions in the InfoSphere Information Server metadata repository.

Before you begin

You must install and configure the CDC environment to enable the creation of subscriptions. The subscriptions read data from Oracle and DB2 and write to Netezza. You must have agents configured to access databases that are to be sources or targets for offload.

See the IBM InfoSphere Change Data Capture version 6.5.2 Information Center [http://publib.boulder.ibm.com/infocenter/cdc/v6r5m2/index.jsp] for information about how to create, or modify CDC agents for DB2, Oracle, or Netezza databases.

You can create offload subscriptions in IBM InfoSphere Change Data Capture only when you are moving data from DB2 or Oracle databases to Netezza databases.
Creating offload subscriptions between other database types is not supported. You cannot create subscriptions if you are using the ODBC connector to move data between databases.

**About this task**

CDC agents apply changes on target databases as changes occur in source databases. You configure access to the source and target databases by defining a CDC data store. A data store contains many elements, including a source or target database, and a source or target instance. The data store name must be the same as the database name in the InfoSphere Information Server metadata repository. Even the letter casing must match.

The data store definitions are local to the access server and do not need to reflect the actual database name that the CDC agent is accessing. For example, you might have a database named SAMP. If you want to use the name SAMPLE for users, you can create the data store with the name SAMPLE. However the name of the database in the access server remains SAMP.

You log in as the CDC administrator to complete the task steps.

**Procedure**

1. Configure CDC Access Server to connect to the CDC agents. You use the Access Server to ensure authorized access to data stores.
   a. Provide a data store name that matches the metadata in the IBM InfoSphere Information Server metadata repository.
   b. Provide the full host name and port number that you defined when you created the CDC agents.
   c. Validate the connection by pinging each agent.
   d. Complete the configuration of database access by providing a user name and password.
2. Assign the data stores to the CDC administrative user.
3. Use Access Manager in the Change Data Capture Management console to view each source and target data store.
4. Compare information in the management console to the information in the metadata repository. You can use IBM InfoSphere Metadata Asset Manager to view databases.
5. Verify that you can create working subscriptions between source databases. For example, try to create subscriptions between databases as follows:
   a. DB2 to Netezza
   b. Oracle to Netezza
IBM InfoSphere Data Click works with data integration products that have their own metadata repositories, such as IBM InfoSphere DataStage and IBM InfoSphere Change Data Capture. The metadata in the repositories of the products must match each other in order for InfoSphere Data Click to successfully generate jobs or subscriptions.

### Configuring InfoSphere Data Click in InfoSphere Blueprint Director

You govern IBM InfoSphere Data Click activities from IBM InfoSphere Blueprint Director. You can set default policies for all InfoSphere Data Click activities, configure connections to source and target databases and create offload blueprints.

#### About this task

The tasks described in this section are completed by an administrator and might need to be completed only once.

#### Installing the InfoSphere Data Click file

To administer, manage and generate IBM InfoSphere Data Click activities, you must install the InfoSphere Data Click plug-in in IBM InfoSphere Blueprint Director on the client tier.

#### About this task

Use the Eclipse-based Software Update feature to add InfoSphere Data Click to InfoSphere Blueprint Director. You install the feature on the client tier where InfoSphere Blueprint Director is installed.

The InfoSphere Data Click administrator completes this task.

#### Procedure

1. Locate the update file com.ibm.im.dataclick.updatesite on the client tier computer. The file is in the `\IBM\InformationServer\Clients\DataClick` directory. Copy the file to a local directory, for example: `c:\DataClick`
2. Open InfoSphere Blueprint Director and select Help > Install New Software.
3. Click Add, and then browse to the directory that contains the update file.
4. Select `com.ibm.im.dataclick.updatesite`, and then provide a name, for example, Data Click Offload.
5. Click OK.
6. Verify that **InfoSphere Blueprint Director Data Click Feature** is listed in the Available Software window. If the feature is not listed, clear the check mark from the **Show only the latest versions of the available software** check box and the **Group items by category** check box.
7. Select **InfoSphere Blueprint Director Data Click Feature**, and then click Next to review the installation details.
8. Accept the terms and agreements, and then click Finish.
10. Click Restart Now on the Software Updates window.
11. Verify that the installation was successful after the restart completes.
a. Select Blueprint > Preferences. You see InfoSphere Data Click in the list on the left side of the window.

**Tip:** If you do not see the InfoSphere Data Click preferences, put your cursor into the filter box in the upper left corner and click the erase icon.

b. Click OK to save the default properties in the Preferences window. Later, you can change the defaults if you choose to do so.

**Setting default policies**

You can specify a set of policies that apply to all offload configurations.

**About this task**

The InfoSphere Data Click administrator completes this task.

**Procedure**

1. Open IBM InfoSphere Blueprint Director.
2. Select Blueprint > Preferences. Select InfoSphere Data Click in the list on the left side of the window.
3. From the Enabled Request drop-down list, select the default action.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate and execute</td>
<td>Enables a user to generate the offload request and run the job or subscription.</td>
</tr>
<tr>
<td>Generate only</td>
<td>Enables a user to only generate an offload request. The job or subscription will need to be started manually in InfoSphere DataStage or IBM InfoSphere Change Data Capture.</td>
</tr>
</tbody>
</table>

4. Specify the minimum and maximum values for offload requests and how they are processed.
5. Click OK to save the profile configuration for your InfoSphere Data Click activities.

**Specifying InfoSphere Information Server connections**

You configure connections to the IBM InfoSphere Information Server metadata repository and IBM InfoSphere DataStage. Connections are needed so that IBM InfoSphere Data Click can process offload requests.

**About this task**

The InfoSphere Data Click administrator completes this task.

**Procedure**

1. Open IBM InfoSphere Blueprint Director.
2. From the application main menu click **Blueprint > Manage Server Connections**.

3. To create a server connection, click **Add** and specify a unique name for the connection, select InfoSphere Information Server as the connection type, and then click **Next**.

4. Enter the connection credentials:
   a. Enter the host and port number of the server on which InfoSphere Data Click is installed.
   b. Provide the user name and password of the InfoSphere Information Server user that you specified for InfoSphere Data Click.
   c. Select the version of InfoSphere Information Server.
   d. Click **Validate Connection** to check that the changes are valid.

5. Click **Finish**.

**What to do next**

You can save the connections that you define within an InfoSphere Data Click blueprint.

### Specifying InfoSphere Change Data Capture connections

You configure connections to enable users to connect to the IBM InfoSphere Change Data Capture Access Server. Database metadata is updated when offload requests are processed.

**About this task**

The InfoSphere Data Click administrator completes this task.

**Procedure**

1. Open IBM InfoSphere Blueprint Director.
2. From the application main menu click **Blueprint > Manage Server Connections**.
3. To create a server connection, click **Add** and specify a unique name for the connection, select Change Data Capture as the connection type, and then click **Next**.
4. Enter the connection credentials:
   a. Enter the host and port number of the server on which the CDC Access Server is installed.
   b. Provide the user name and password of the CDC Access Server that you specified for IBM InfoSphere Data Click.
   c. Select the IBM InfoSphere Information Server that is configured for InfoSphere Data Click and that has access to the CDC Access Server. The connection is the one that you specified in “Specifying InfoSphere Information Server connections” on page 15, Step 4.
   d. Click **Validate Connection** to check that the changes are valid.
5. Click **Finish**.

**What to do next**

You can save the connections that you define with an InfoSphere Data Click blueprint.
Chapter 4. Offloading data

You specify where you want to offload data to and where you want to offload data from. You can also view offload requests.

About this task

Most of the tasks that are described in this section are performed by an administrator.

The tasks performed by InfoSphere Data Click users are viewing, tailoring, and submitting offload requests.

Creating an InfoSphere Data Click blueprint

You can create one blueprint to specify more than one offload configuration, with various source and target configurations. Alternatively, you can create multiple blueprints that specify different source-to-target configurations. You can also use offload blueprint templates.

Before you begin

You need to have already defined source and target assets.

About this task

An IBM InfoSphere Data Click blueprint must contain at least one element that represents the source asset, one element that represents the target asset, and at least one Data Click Activity element.

The InfoSphere Data Click administrator completes this task.

Procedure

1. Open IBM InfoSphere Blueprint Director.
2. Click File > New > Blueprint from the application main menu to begin creating a blueprint.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use an offload blueprint template | 1. Click Create blueprint from template.  
2. Select Data Click Offloading from the list.  
3. Click Finish. You see a template that you can modify. |
| Create an offload blueprint | 1. Click Create empty blueprint.  
2. Provide a name for the blueprint in the New blueprint field.  
3. Click Finish. You see a an empty blueprint that you can create a diagram in. |
3. Create a diagram of the sources, target, and operations that you want to allow users to use within InfoSphere Data Click. The following steps illustrate one way that you can create a blueprint for InfoSphere Data Click.
   a. Drag database assets from the asset browser and drop the assets onto the canvas. The asset browser displays database information from the metadata repository.

   b. From the Palette pane, click **Operations**.

   c. Drag the **Data Click Activity** element onto the blueprint canvas. Position the element between your source and target assets.

   d. Connect the **Data Click Activity** to the source and target assets.
      1) Click on the line from the **Data Click Activity** and drag it to the target database.
      2) Click on the line from the **Data Click Activity** and drag it to the source database.

   4. From the application main menu, click **File > Save**.

**What to do next**

Next, you configure the InfoSphere Data Click blueprint.
Configuring and publishing an offload

After you create a blueprint that documents the sources and targets that can be part of an offload, you can configure an IBM InfoSphere Data Click offload.

Before you begin

You must have a blueprint that includes defined sources, a target, and at least one Data Click Activity element.

About this task

Configuration tasks include specifying the sources and target for offload, processing engines, and policy overrides.

The InfoSphere Data Click administrator completes this task.

Procedure

1. Open IBM InfoSphere Blueprint Director.
2. Click Window > Show View > Blueprint Navigator, and then navigate to the InfoSphere Data Click blueprint.
3. Open the blueprint.
4. Right-click the Data Click Activity element, and select Configure InfoSphere Data Click.
5. Configure the InfoSphere Data Click activity.
   a. Choose the IBM InfoSphere Information Server connection where the offload is to run and then click Next.
   b. Choose the source and target databases that the user is limited to extracting data from and writing data to. You must choose the schemas within each database that the user is limited to. You can select multiple schemas when available, and then click Next to proceed.
   c. Enter the information for the computer that is to process offload requests. You provide information for the InfoSphere Information Server engine and for InfoSphere DataStage. Optionally, you can specify IBM InfoSphere Change Data Capture Access Server if you are moving data from DB2 or Oracle databases to Netezza databases. Click Next to proceed.
   d. Optional: Override any policy defaults that are applied for any offload from this Data Click activity.
      a. Click Finish.
6. Save the blueprint. A small icon, , is next to the Data Click Activity element, indicating a valid configuration.
7. Optional: Repeat the configuration steps for any other Data Click Activity elements in the blueprint.
8. Publish the blueprint to users who intend to generate offload requests.

Tip: When you publish, you see a dialog box that gives you the option to open the published blueprint. If you click on the link to the published blueprint, a blueprint viewer window opens. You can copy the URL address displayed at the top of the viewer window and paste the URL address into an email. You can then share the email with users who plan to use the blueprint to create offload requests.
What to do next

On the client tier, you open either IBM InfoSphere Metadata Workbench or IBM InfoSphere Business Glossary to see the published InfoSphere Data Click blueprint.

Related information:

Distributing published blueprints

After you publish a IBM InfoSphere Data Click offload blueprint, you can distribute a link to the blueprint to users who plan to submit offload requests.

Before you begin

You must have a published blueprint that is configured for offload requests.

About this task

You can access a blueprint at the time you publish the blueprint or from within IBM InfoSphere Metadata Workbench.

The InfoSphere Data Click administrator completes this task.

Procedure

1. Open the published blueprint

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>At the time you click Publish from within IBM InfoSphere Blueprint Director</td>
<td>From within the Publish dialog box, click as indicated to open the published blueprint. The InfoSphere Blueprint Director Viewer opens.</td>
</tr>
</tbody>
</table>
| From InfoSphere Metadata Workbench          | 1. From within the InfoSphere Metadata Workbench, click Asset Type > Blueprint and search for the blueprint.  
                                          | 2. Open the blueprint and click View Blueprint.                                                                                                     |

2. Copy the URL address at the top of the InfoSphere Blueprint Director Viewer window.
3. Paste the URL address you copied into an email. You can share the URL address with other team members.

Viewing and submitting offload requests

In either an IBM InfoSphere Metadata Workbench or IBM InfoSphere Business Glossary client, you open the published InfoSphere Data Click blueprint. From the client, through a viewer, you then can open the InfoSphere Data Click wizard to view and modify offload requests.

Before you begin

You must have a published blueprint that is configured for offload requests.
You can open and view the published blueprint in either an InfoSphere Metadata Workbench or InfoSphere Business Glossary client.

About this task

From your client you open a viewer and from the viewer you open a wizard. You use a wizard to review and tailor offload requests. The configuration set by the IBM InfoSphere Data Click administrator, combined with your specifications in the wizard, determine whether InfoSphere DataStage or IBM InfoSphere Change Data Capture is used to process offload requests.

The InfoSphere Data Click user completes this task.

Procedure

1. From an InfoSphere Metadata Workbench or InfoSphere Business Glossary client, open the blueprint that is configured for offload requests. When you open the blueprint, the blueprint is shown in an IBM InfoSphere Blueprint Director viewer.
2. On the canvas, select the Data Click Activity element that you want to implement.
3. In the pane on the right side of the viewer window, under Data Click: Offload click the offload request configuration that you want.
   The InfoSphere Data Click wizard is displayed showing the target database and schemas that you can offload to.
4. In the Select Target pane, you can select databases or schemas to offload to. You then click Next to continue to the Source pane.
5. In the Select Sources pane, you can select tables, table columns, or a combination of the two to offload from. You then click Next to continue to the Configure Options pane.
6. In the Configure Options pane, you can specify options that include scheduling and labeling of target tables. The options you have are limited by the policies set by the InfoSphere Data Click administrator. You then click Summary.
7. Review the information in the Summary pane. You see the name generated for the offload request and the policies that apply to the offload request.
8. Click Offload. The offload request is generated and submitted to IBM InfoSphere DataStage or IBM InfoSphere Change Data Capture for processing.

Related information:

- Viewing blueprints in InfoSphere Business Glossary
- Viewing blueprints in InfoSphere Metadata Workbench

Tailoring the offload request

You can accept predefined specifications or specify details in the wizard.

You open the wizard from an IBM InfoSphere Data Click blueprint. When a blueprint is created, the administrator specifies policies that dictate what you can do in the wizard. The administrator also specifies the target and sources that you can use for an offload request.

In the offload wizard, you can view panes that prompt you for information that is needed before an offload can be processed. Each pane has a tab. A check mark on a tab indicates that the information in the pane is adequate and you do not need to provide additional information. If no check mark exists, you must provide
information in the pane. If all tabs are marked with check marks, you can proceed to the **Summary** pane and submit the offload request with as few as two clicks.

During InfoSphere Data Click set up, the metadata for the database sources and targets is stored in the metadata repository. You can view the database metadata from the offload wizard.

In the Select Target pane, when you select a schema on the left side of the pane, you can see the database tables in the schema listed on the right side of the pane. The database tables that are listed are already defined in the metadata repository for the selected schema.

In the Select Sources pane, you can select any of the following items:

- The entire table
- All the tables in a schema
- Individual tables
- Specific columns

In the Configure Options pane, you can either only generate an offload request, or generate and execute an offload request. What you can do is determined by the policy set by the administrator. Whether you can schedule repeat submittals of offload requests is also predetermined. If you set up a refresh schedule, you can set up a periodic refresh (which is processed as a job) or set up for continuous updates (which is processed as a CDC subscription). You can use advanced options to control aspects of how target tables are generated.

The Summary pane describes how the offload request is processed. You can see which application, IBM InfoSphere DataStage or IBM InfoSphere Change Data Capture is used to process the request. You can see the sources and target specified and the policies that are in place.

A unique name is generated for the offload request so that the request can be tracked.

The target table action (create, replace, or append) is generated based on the presence of matching metadata in the repository.

### Viewing offload activities

You can access a view of offload activities from either an InfoSphere Metadata Workbench or InfoSphere Business Glossary client, or directly from applications that process the offload job or subscription.

From either an InfoSphere Metadata Workbench or InfoSphere Business Glossary client, you can open the IBM InfoSphere DataStage and QualityStage Operations Console to view your offload activities. The Operations Console gives you a view of offload job instances that were specified as **Generate Only** or **Generate and Execute**. You can view job instances that are running or are scheduled to run.

As an administrator, you can use the schedule monitor functions in the Information Server Web console to view offload requests that are specified for periodic refresh.
Also as an administrator, you can use IBM InfoSphere Metadata Workbench to view the metadata associated with offload jobs and subscriptions. You can see changes to the target database metadata.

Viewing scheduled offloads

You can view offload requests that are specified for periodic refresh. You use the schedule monitor functions in the IBM InfoSphere Information Server Web console to view offload activities. You can also deactivate scheduled offloads in the console.

About this task

This task is completed by an administrator.

Procedure

1. In the Web console, click Schedule Monitoring > View schedules.
2. Click New Scheduling View.
3. Create and save a new view.
   a. Complete the Name and Description fields.
   b. In the Access field, select Shared.
   c. Click Save and Close.
4. Select the view you created and click View Schedules.
   All offload requests specified for scheduled refreshes are displayed.
5. Select an offload request and select View Task to view the offload information.
6. Optional: You can click View forecast to see when the offload request is next scheduled to run.

Checking offload jobs in the Operations Console

If IBM InfoSphere DataStage and QualityStage Operations Console is installed and configured on the engine tier that is used by IBM InfoSphere Data Click, users can check the status of offload requests. Offload requests are viewed in the console as a set of job instances. The set of job instances shares a common name but are distinguished by a number appended to the name.

About this task

When you select to open a view of the offload request, you might need to authenticate. You must provide the user name and password that enables you to access the Operations Console.

Procedure

1. In the IBM InfoSphere Metadata Workbench or IBM InfoSphere Business Glossary client, open the InfoSphere Data Click blueprint.
2. On the canvas, select the Data Click Activity element for the offload activity that you want to view.
3. In the pane on the right side of the viewer window, under Other: click the offload request that you want to view. In the Operations Console, you can see the details of the job of the offload request.
4. To view other jobs associated with the offload activity, close the window and, while still in the Operations Console, search for the names of jobs that match the offload request.
Viewing metadata generated by offloads

You can track events and processes that occur during offload by viewing the operational metadata.

About this task

The tasks described in this section are completed by an administrator.

Capturing operational metadata

You can verify that operational metadata from offload jobs becomes part of the database metadata that is stored in metadata repositories. Run the Importer utility regularly to ensure that the most current information is in the metadata repository.

Before you begin

Before you can collect operational metadata, you must enable operational metadata either for the project that contains the job or for the job itself. For more information, see Managing operational metadata from job runs.

You must have the role of Metadata Workbench Administrator to complete these task steps.

About this task

You ensure that required files and access authorizations are in place. You run the Importer utility to import operational metadata.

Procedure

1. Generate and run an offload request to create a job instance.
2. Verify that xml files exist and contain operational metadata from the job.
   a. On the InfoSphere Information Server engine that the job runs on, navigate to the directory ..\ASBNode\conf\etc\XmlFiles. Operational metadata is captured in the XML files.
3. In a text editor, update the ..\ASBNode\conf\runimport.cfg file. Provide a user name that is assigned the Metadata Workbench Administrator role, password, and host information that is required to access the metadata repository of InfoSphere Information Server. For more information about updating the runimport.cfg, see Parameter values for the Run Importer utility.
4. From the command line, start the Run Importer utility on the InfoSphere Information Server engine.
   • On Microsoft Windows operating systems, run RunImportStart.bat in the directory IBM\InformationServer\ASBNode\bin.
   • On UNIX operating systems, run RunImportStart.sh in the directory opt/IBM/InformationServer/ASBNode/bin.

The Importer utility processes the XML files and imports the metadata into the repository.
5. In InfoSphere Metadata Workbench, run the Manage Lineage utility to identify relationships between tables and views, and the jobs that access them.
Viewing metadata from jobs and subscriptions

You can use IBM InfoSphere Metadata Workbench to view the metadata associated with offload jobs and subscriptions.

About this task

You must have Metadata Workbench User or Administrator authorization level to view objects in Metadata Workbench.

You can use the Metadata Workbench search capabilities to search directly for jobs or CDC Mapping Extension documents, or you can follow these task steps.

Procedure

1. Open IBM InfoSphere Metadata Workbench.
2. Select Database Table.
3. Click Find and select a database table that was generated as an offload target. You specified the target table name in the offload wizard. A job created the table.
4. Open the database table view. You see information about the table.
5. Click Data Lineage from the task list on the right side of the window.
6. View the data. You can see information about the job if the offload request was processed by IBM InfoSphere DataStage. You can see the mapping extension document if the offload request was processed by an IBM InfoSphere Change Data Capture subscription.

Running jobs or starting subscriptions from offload requests

You can run offload jobs from within IBM InfoSphere DataStage and QualityStage Director. You can start offload subscriptions from within the IBM InfoSphere Change Data Capture Management Console.

About this task

Users might create offload requests that are specified as Generate only. You, as an InfoSphere Data Click administrator, can run jobs or start subscriptions for offload request that users create. You can repeat the run of jobs or reactivate subscriptions.

Submitting or resubmitting offload jobs

You can manage job instances that are generated by IBM InfoSphere Data Click. InfoSphere Data Click creates a parameter set value file for each offload request. You can use the value file to run an offload.

About this task

When an offload request is assigned to IBM InfoSphere DataStage for processing, InfoSphere Data Click generates a value set file. The value set file contains all the parameters needed by InfoSphere DataStage and job templates that are used to complete the offload request. These value sets are stored in a directory associated with the InfoSphere Data Click project.

This task describes how to access the value set file from IBM InfoSphere DataStage and QualityStage Director, you can also access the value set file from the IBM InfoSphere Information Server directory on the engine tier computer. The file is
located in the following directory: `<IS root>\Server\Projects\DataClick\ParameterSets\DataClick_ParameterSet\<Offload Name>.txt`.

This task is completed by an InfoSphere Data Click administrator.

**Procedure**

1. Log on to the Designer client.
2. In the Data Click project, locate the DataClick folder and select the DataClick_JobController sequence operator.
3. Click the Run icon.
4. In the Job Run Options window, select the appropriate value set file. The value set file name is the same as the offload request name. The values from the value set file populate parameter fields.
5. Click Run. The job runs with the parameters from the value set applied.

**Submitting or resubmitting offload subscriptions**

You can manage subscriptions that are generated by IBM InfoSphere Data Click.

**About this task**

When offload request specifies continuous offload, IBM InfoSphere Change Data Capture processes the subscription. You can access the generated subscription in the CDC Management Console. You can start the subscription when you want.

**Note:** The only offload subscriptions that are supported in IBM InfoSphere Change Data Capture are subscriptions where you are moving data from DB2 or Oracle databases to Netezza databases. Creating offload subscriptions between other database types is not supported. You cannot create subscriptions if you are using the ODBC connector to move data between databases.

**Procedure**

1. Log in to the CDC Management Console. In the Server Name field, select the computer where CDC Access Server is installed. The server is the same as the server that you specify as CDC Connection for InfoSphere Data Click in InfoSphere Blueprint Director.
2. Locate the subscription. The subscription name is the same as the offload request name that was generated in the offload wizard.
3. Right-click the subscription, and select one of the following processes.

   **REFRESH**
   
   Completes the initial synchronization of the tables from the source database to the target.

   **MIRROR**
   
   Completes the replication of changes to the target table. When
InfoSphere CDC mirrors data for replication, it continuously replicates changed data from a source system to the target system.
Chapter 5. Managing change to sources and targets

You can update metadata when changes occur to database objects that exist in an IBM InfoSphere Data Click environment. You can also add new databases, or schemas to an existing environment.

The InfoSphere Data Click administrator completes this task.

Generally, when database objects that are currently used in InfoSphere Data Click activities change, you do not need to do anything. If you change tables or columns within a source or target, existing data click blueprints automatically use the changed objects.

If you want to add databases or schemas, or if the repository identifier for a database or schema changes, you complete the following tasks:

- Import the database objects into the metadata repository
- Update your blueprint. Configure the Data Click Activity to use the new or changed assets.

When the repository identifier for a database or schema changes, existing configurations that use the changed database or schema, no longer work. You see an error message that indicates that no valid sources are targets are found.

If you change a database or schema, but the repository identifier does not change, you only need to import the changed database objects into the metadata repository.

Related tasks:

- "Making database objects available for offload activities in InfoSphere DataStage" on page 10
- "Configuring and publishing an offload" on page 19

You must import metadata for every source and target database that you want to make available for offload request. One reason that you import the metadata is to ensure that connection information is available during the processing of offload request.

After you create a blueprint that documents the sources and targets that can be part of an offload, you can configure an IBM InfoSphere Data Click offload.
Chapter 6. Troubleshooting InfoSphere Data Click

These problems and workarounds are related to metadata consistency and connection issues.

Based on the message or symptom, complete the action specified.

Table 1. Troubleshooting InfoSphere Data Click

<table>
<thead>
<tr>
<th>Message or symptom</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offload to a database fails. Offloading of data from tables whose column names contain reserve keywords can cause problems. Reserve keywords include POSITION, COPY, DEC, and RANGE.</td>
<td>You can use double quotes to maintain letter case. You put double quotes (&quot; ) around column names that contain reserve keywords. See “Using double quotes around reserve words” on page 32 for task steps. Alternatively, change the source table column names. Ensure that the column names do not contain reserve keywords. After making changes, try the offload again.</td>
</tr>
<tr>
<td>&lt;Source/Target&gt; database Connection is missing in the metadata repository</td>
<td>• Verify that the metadata was imported using InfoSphere DataStage and that the connection object is saved with the IBM InfoSphere Change Data Capture data store. • Verify that the connection used is a supported database and is named correctly: DB2, NetezzaSQL, or Oracle • Re-associate and save the connection object with the database. Load the connection object on the import page and save.</td>
</tr>
<tr>
<td>java.lang.NoClassDefFoundError: com.datamirror.ea.api.ApiException</td>
<td>Make sure that the CDC shared library class path is configured properly.</td>
</tr>
<tr>
<td>• CDIW4006E Failed to connect to a DataStore xxxxx with error Unable to connect to agent. Connection may have been lost. (where xxxxx is a CDC datastore name) • The WebSphere Application Server sstem.out log contains: [7/23/12 9:52:58:172 PDT] 000000b2 OffLoadReques E java.lang.NullPointerException java.lang.NullPointerException at com.ibm.im.databridge.datastage.GenerateValueSetPOJO.createValueSet (GenerateValueSetPOJO.java:234)</td>
<td>• Verify that the CDC agent connected to the data store is up and running • Verify that the data store name is defined in the CDC Access Server. If the name does not match, you might also see a message: java.lang.NullPointerException • Verify that the templates were imported into InfoSphere DataStage.</td>
</tr>
</tbody>
</table>
Table 1. Troubleshooting InfoSphere Data Click (continued)

<table>
<thead>
<tr>
<th>Message or symptom</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are configuring an InfoSphere Data Click activity in InfoSphere Blueprint</td>
<td>Even though these values are displayed when you select an InfoSphere Change Data Capture connection, they are relevant only if you select an InfoSphere DataStage connection. These values are not valid for InfoSphere Change Data Capture.</td>
</tr>
<tr>
<td>Director, and select the InfoSphere Change Data Capture connection. On the on the</td>
<td></td>
</tr>
<tr>
<td>Policy and Constraints page, you select values for Maximum Records to Extract for</td>
<td></td>
</tr>
<tr>
<td>Each Table and Maximum Number of Parallel Jobs. However, you are not sure how these values are used in InfoSphere Change Data Capture.</td>
<td></td>
</tr>
<tr>
<td>You receive an error message when you run an offload to replace a target table in a</td>
<td>To work around this issue, use the IBM Teradata driver to create the ODBC connection to the Teradata database that you are using in the offload.</td>
</tr>
<tr>
<td>Teradata database. You will receive the following error message if you run the</td>
<td></td>
</tr>
<tr>
<td>offload with an ODBC connector using the Teradata ODBC driver:</td>
<td></td>
</tr>
<tr>
<td>= 25000: Native Error Code = -3,932: Msg = [Teradata][ODBC Teradata Driver][Terad</td>
<td></td>
</tr>
<tr>
<td>ata Database] Only an ET or null statement is legal after a DDL Statement.</td>
<td></td>
</tr>
</tbody>
</table>

Using double quotes around reserve words

You must modify jobs in the InfoSphere Data Click project. You change the jobs to maintain the case-sensitivity of database object names.

If you are offloading data from DB2 to Netezza, you open the job `DB2ToNetezza_OffloadJob` in the Jobs/DataClick/OffloadJobs folder. In the job, complete the following steps:

1. Double-click the Netezza Load stage to open the stage editor.
2. In the Usage section, change the property Enable case-sensitive identifiers to Yes.
3. Save your changes and close the stage editor.
4. Compile the following jobs:
   - Db2ToNetezza_Controller
   - Db2ToNetezza_OffloadJob
   - Db2ToNetezza_OffloadJobInstantiator
   - Db2ToNetezza_ParameterParser
5. Save and exit the project.

If you are offloading data from Oracle to Netezza, open the job `OracleToNetezzaOffloadJob` in the Jobs/DataClick/OffloadJobs folder. In the job, complete the following steps:

1. Double-click the Netezza Connector1 stage to open the stage editor.
2. In the Usage section, change the property Enable case-sensitive identifiers to Yes.
3. Save your changes and close the stage editor.
4. Compile the following jobs:
• OracleToNetezza_Controller
• OracleToNetezza_OffloadJob
• OracleToNetezza_OffloadJobInstantiator
• OracleToNetezza_ParameterParser

5. Save and exit the project.
Appendix A. Product accessibility

You can get information about the accessibility status of IBM products.

The IBM InfoSphere Information Server product modules and user interfaces are not fully accessible. The installation program installs the following product modules and components:

- IBM InfoSphere Business Glossary
- IBM InfoSphere Business Glossary Anywhere
- IBM InfoSphere DataStage
- IBM InfoSphere FastTrack
- IBM InfoSphere Information Analyzer
- IBM InfoSphere Information Services Director
- IBM InfoSphere Metadata Workbench
- IBM InfoSphere QualityStage

For information about the accessibility status of IBM products, see the IBM product accessibility information at [http://www.ibm.com/able/product_accessibility/index.html](http://www.ibm.com/able/product_accessibility/index.html).

Accessible documentation

Accessible documentation for InfoSphere Information Server products is provided in an information center. The information center presents the documentation in XHTML 1.0 format, which is viewable in most Web browsers. XHTML allows you to set display preferences in your browser. It also allows you to use screen readers and other assistive technologies to access the documentation.

The documentation that is in the information center is also provided in PDF files, which are not fully accessible.

IBM and accessibility

See the [IBM Human Ability and Accessibility Center](http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.
Appendix B. Contacting IBM

You can contact IBM for customer support, software services, product information, and general information. You also can provide feedback to IBM about products and documentation.

The following table lists resources for customer support, software services, training, and product and solutions information.

*Table 2. IBM resources*

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description and location</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IBM Support Portal</strong></td>
<td>You can customize support information by choosing the products and the topics that interest you at <a href="http://www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere_Information_Server">www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere_Information_Server</a></td>
</tr>
<tr>
<td><strong>Software services</strong></td>
<td>You can find information about software, IT, and business consulting services, on the solutions site at <a href="http://www.ibm.com/businesssolutions/">www.ibm.com/businesssolutions/</a></td>
</tr>
<tr>
<td><strong>My IBM</strong></td>
<td>You can manage links to IBM Web sites and information that meet your specific technical support needs by creating an account on the My IBM site at <a href="http://www.ibm.com/account/">www.ibm.com/account/</a></td>
</tr>
<tr>
<td><strong>Training and certification</strong></td>
<td>You can learn about technical training and education services designed for individuals, companies, and public organizations to acquire, maintain, and optimize their IT skills at <a href="http://www.ibm.com/software/sw-training/">http://www.ibm.com/software/sw-training/</a></td>
</tr>
</tbody>
</table>
Appendix C. Accessing and providing feedback on the product documentation

Documentation is provided in a variety of locations and formats, including in help that is opened directly from the product client interfaces, in a suite-wide information center, and in PDF file books.

The information center is installed as a common service with IBM InfoSphere Information Server. The information center contains help for most of the product interfaces, as well as complete documentation for all the product modules in the suite. You can open the information center from the installed product or from a Web browser.

Accessing the information center

You can use the following methods to open the installed information center.

- Click the Help link in the upper right of the client interface.

  **Note:** From IBM InfoSphere FastTrack and IBM InfoSphere Information Server Manager, the main Help item opens a local help system. Choose Help > Open **Info Center** to open the full suite information center.

- Press the F1 key. The F1 key typically opens the topic that describes the current context of the client interface.

  **Note:** The F1 key does not work in Web clients.

- Use a Web browser to access the installed information center even when you are not logged in to the product. Enter the following address in a Web browser: http://host_name:port_number/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.home.doc/ic-homepage.html. The host_name is the name of the services tier computer where the information center is installed, and port_number is the port number for InfoSphere Information Server. The default port number is 9080. For example, on a Microsoft® Windows® Server computer named iisdocs2, the Web address is in the following format: http://iisdocs2:9080/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/iisinfsrv_home.html.


Obtaining PDF and hardcopy documentation

- A subset of the PDF file books are available through the InfoSphere Information Server software installer and the distribution media. The other PDF file books are available online and can be accessed from this support document: [https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1](https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1)

- You can also order IBM publications in hardcopy format online or through your local IBM representative. To order publications online, go to the IBM Publications Center at [http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss](http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss)
Providing comments on the documentation

Your feedback helps IBM to provide quality information. You can use any of the following methods to provide comments:

- To comment on the information center, click the Feedback link on the top right side of any topic in the information center.
- Send your comments by using the online readers’ comment form at www.ibm.com/software/awdtools/rcf/.
- Send your comments by e-mail to comments@us.ibm.com. Include the name of the product, the version number of the product, and the name and part number of the information (if applicable). If you are commenting on specific text, include the location of the text (for example, a title, a table number, or a page number).
- You can provide general product feedback through the Consumability Survey at http://www.ibm.com/software/ucd/consumability/.
Notices and trademarks

This information was developed for products and services offered in the U.S.A.

Notices

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites.
sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

The following terms are trademarks or registered trademarks of other companies:

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other countries.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

The United States Postal Service owns the following trademarks: CASS, CASS Certified, DPV, LACS<sup>Link</sup>, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS and United States Postal Service. IBM Corporation is a non-exclusive DPV and LACS<sup>Link</sup> licensee of the United States Postal Service.

Other company, product or service names may be trademarks or service marks of others.
Index

Special characters
.dsx files 9

A
administrator
Information Server for Data Click 7
Websphere Application Server for Data Click 12

B
blueprint 17

C
CDC API 12
CDC data stores 12
CDC subscriptions 26
client 20
components 5
viewer 20
configure offload 19
connect
InfoSphere Data Click to InfoSphere Change Data Capture 16
InfoSphere Data Click to InfoSphere Information Server 15
connectivity
metadata
sources and target 10
sources and target 10
credentials 7
customer support
contacting 37

D
Data Click file 14
Data Click job templates 9
data stores, CDC 12
DataStage jobs 25
default settings 15

E
error messages 31

G
governance 14

I
InfoSphere Data Click
operational metadata 24
roles 3
InfoSphere Data Click administrator
role 3
InfoSphere Data Click user role 3
installing Data Click 14

J
job instances 23
job templates 9
jobs
submit, InfoSphere Data Click 25

L
legal notices 41
limitations 31

M
metadata 24
metadata consistency 10

O
offload
configure 19
modify request 21
schedule 21
status of request 23
view activities 22
view request 20
view schedule 23
operational metadata 24
Operations Console 23
Data Click jobs 23

P
plug-in
Data Click in InfoSphere Blueprint Director 14
policies 15
product accessibility
accessibility 35
product documentation
accessing 39
project properties 5

R
roles
InfoSphere Data Click 3
runtime propagation 5

S
schedule offloads 21
modify 23
security 7
settings 15
shared library
InfoSphere Change Data Capture Access Server 12
software services
contacting 37
subscriptions
submit, InfoSphere Data Click 26
support
customer 37

topology 5
trademarks
list of 41

U
update file 14
user role 8

W
view
offload activities 22
offload requests 20
viewers 20
wizard 20

© Copyright IBM Corp. 2012, 2013